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SECTION 1
Background

This document is designed to guide an MMC GIS/Mapping team member through all required steps to
produce a map series conforming to the MMC Inundation mapping standards. In order to produce the
mapping products for the MMC, the GIS/Mapping team member should fully understand the source of the
inundation data they are mapping and the goals of the products that they are developing. This section
describes each step in the standard MMC process preceding mapping and gives a rough description of
the data produced by that step and how it impacts the mapping. For more information see the
corresponding section of the MMC SOP.

1.1 PRE-MODEL DATA

During the pre-model data development phase of an MMC project, the MMC GIS/Mapping team is
responsible for developing the vector and raster datasets used to set up the model.

1.2 MODELING

The modeling phase of any MMC project is where most of the analysis is performed. The Hydraulic
Modelers take the pre-model datasets and build on them to produce complete models using separate
modeling software. The majority of models developed for the MMC will use HEC-RAS modeling software.

The output depth grids from the hydraulic modeling efforts are put into consequence models based in the
HEC-FIA or LifeSIM software. This software uses depth and arrival time information to model impacts
such as life-loss and economic impact based on a structure inventory. The default dataset used for the
structure dataset is derived from Census Block data pulled from the HAZUS database. These structures
are used in the profile graphs to show where population density is highest.
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SECTION 2
Production Requirements

21 SOFTWARE REQUIREMENTS
There are some specific software requirements that must be met in order to follow the steps in this guide.
e ESRI ArcGIS 10, Arcinfo required for some steps (or equivalent)

o Spatial Analyst Extension
o 3D Analyst Extension

Connection to services.arcgisonline.com
MMC Utilities Toolbar (optional)

Adobe Acrobat Pro (latest version)
Microsoft Office 2007

ProjectWise Explorer (version V8i)

2.2 THE MMC UTILITIES TOOLBAR
To install the MMC Utilities Toolbar:

Launch the MMC_Mapping_Addin.esriAddIn icon to begin the MMC Tools Setup Wizard
Follow the steps onscreen to install the tool

Open ArcMap.

Right click on any empty portion of the toolbar and activate the MMC Ultilities Toolbar.
This should open the toolbar and you can place it anywhere on the mxd that you want.

aorON=

Figure 2-1 displays the MMC Utilities Toolbar:

MM Liilities Toolbar

1":4.54 mi * MMCToolsHelp- il ® R M &S E QL e lne & L EH W

Figure 2-1. MMC Ultilities Toolbar

2.3 QUALITY REQUIREMENTS

The work performed using this guide is subject to review as described in Appendix 4.3.7 MMC Mapping
Review Guide. Reviews are to be performed by internal GIS team members, H&H team members and
headquarters representatives as assigned.
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The following files will be used in the production of this Mapping Product:

Table 2-1. Map Template File Names

Product File Name
Cover Page 441 MMC_Cover_Page Levee.pptx
Map Notes | 4.4.2 MMC_MapNotesl Levee.mxd
Map Notes Il 4.4.3 MMC_MapNotesll_Levee.mxd
Sheet Index 444 MMC_Sheet_Index Levee.mxd

Arrival Time Sheets

445 MMC_Levee Arrival_Maps.mxd

Depth Grid Sheets

446 MMC_Levee Depth Maps.mxd

Notes Il Table Template

4.4.7 MapNotes2_ Tables Study Levee.xlsx

2.5 DELIVERABLE PRODUCTS

The MMC GIS/Mapping team is responsible for a number of deliverable datasets and products. Below is
a brief summary of the products that the team is responsible for. This document describes how to develop
the PDF maps and the data that is used in the other deliverable products. Please refer to any referenced
document for more information about a specific topic.

e Flat PDF files—map books in optimized and full resolution .pdf format for printing and digital

distribution.

o Web Map—interactive online web mapping application serving the data produced in this
process.

o GIS Geodatabase—Enterprise level geodatabase for storage of all spatial data generated by
the MMC.
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SECTION 3
Data Preparation for Levee Maps

Output data may need to be revised based on assumptions made during the modeling process. If any
datasets are missing from the model data that are needed to complete these steps, contact the modeler
and request that they be exported from the model.

3.1 REQUIRED DATASETS

Two dimensional models are capable of producing different datasets than the one dimensional HEC-RAS
software. The following datasets should be exported from the modeling software for use in Levee Maps:

e Arrival Time Grid at Cell — This grid is to be used for arrival time.
e Max Depth at Cell — This grid is to be used for maximum depth.

3.2 CREATE WORKING GEODATABASE

1. If it does not already exist, create a new folder under the Study Area root called Mapping.

2. If you had to generate the Mapping folder, create the three following folders in the Mapping
folder: ArcGISMaps, GIS_Data, and PDF_Maps.

3. Using ArcCatalog, create a new empty file geodatabase named Inundation_[Levee Name] in
the GIS_Data folder.

3.3 CLIPPING RAS OUTPUTS FOR GRIDS

Revisions may be necessary to the model output grids depending on the assumptions made during the
modeling process. Work with the modeler to determine if the raw output from the model is appropriate or if
any areas need to be removed from the output prior to being used in an inundation map.

If the model output extent needs to be modified:

1. Digitized a polygon of the area that will remain in the inundation maps. Make sure the
shapefile is the same projection as the model output grids.

2. Add the polygon layer to the map document with the arrival time grid and depth grid to the
map document.

3. Open ArcToolbox and Navigate to Spatial Analyst Tools > Extraction - Extract by Mask.

4. Run the extract by mask feature on both the depth and arrival grids. This process may take a
significant depending on the size of the inundation extent.

5. Create a folder for each modeled scenario that will have a map created. Each scenario will
have unique data in the next steps.

3.4 ADJUSTING ARRIVAL GRIDS FOR MODEL BREACH TIMES

Arrival time grids that come from RAS may be calculated from model start time and not breach initiation
time. Work with the modeler to determine what assumptions were used during the modeling process. If
arrival time output grids were created from start of model, the arrival time grids will need to be adjusted for
each scenario.

1. Determine the amount of time from start of model to breach time for each scenario. This will
differ for each scenario and will need to be identified by the modeler.

2. In ArcToolbox navigate to Spatial Analyst Tools > Math - Minus.

3. Run the Minus tool on the clipped arrival grid created in the above section. Be sure to use the
value provided by the modeler for the scenario you are working with (difference between
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start of model and breach time). Make sure to save the file in the appropriate folder for the
scenario and call the output arrival_time.

. Minus - O X
Input raster or constant value 1 Output raster
| arr_clip | &
Input raster or constant value 2 The output raster.
[EDG.?S l‘ =] The cell values are the
Output raster result of subtracting the
| E:\GIS\MMC \Levees\Hickman Mapping\GIS_Data'\Raster\HFP _50P\arrival_time | @ second input from the first.

oK Cancel Environments... << Hide Help Tool Help

Figure 3-1. Minus Tool

3.5 CONSOLIDATE DATA INTO WORKING GEODATABASE

Prior to mapping, the layers that will be used in the maps should be consolidated into the working
geodatabase. This will speed processing because we will only have data that is displayed in the maps in
our geodatabase.

1. Start a new ArcMap session.
2. Add the clip polygon used in the previous steps to the map.
3. Add the following layers to the map session from the MMC_National_Data geodatabase1:

COE_NID_DAMS
dtl_cntry_In

dtl_cntry

dtl_cnty_In

dtl_cnty

dtl_st In

dtl_st

Railroad
CityCivilDivisions
CityCivilDivisions_In
MMC_DetailSheetExtents
MMC_StandardSheetExtents
MMC_Two_D_Points
mgrs_region
levee_centerline
floodwall_line
closure_structure_line

O 0O 0O O0OO0OO0OO0OO0OO0OO0OO0OO0OOoOO0oOOoOO0OO0

'See 4.1.6 Map Data Spec for sources of all national datasets, requires MMC National Database v.2012, available in MMC support
files.
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4. Use the Select by Location tool located in the Selection menu to select features from the
MMC_DetailSheetExtents and MMC_StandardSheetExtents layers that intersect the
InundationArea layer produced earlier.

Selection Tools Window Help Select By Location el |

Select By Attributes. .. Lets wou select Features From one or more layers based on where they are
% — located in relation to the Features in another laver,

Select By Location...
“ I - I wank ko

Select By Graphics

it arap Iselect Features From j

@ Zoom T Selected Features the Follawing layer(s):
@ Pam To Selected Features (] USACE_Dams
25 Statistics. .. [ standard_Sheets

Set Selectable Lavers. ..

Zlear Selecked Features

Interactive Selection Method — p

Cptions, ..

[ only show seleckable layers in this lisk
that:

Iintersect w7

Kl

the features in this laver:

[ USACE_Dams 4

I | Use selected features {0 Features selecked)

[~ apply a buffer to the Features in USACE_Dams
of: [0,000000 |pecimal Degress |

Help | (4 | Sppliy | Close

Figure 3-2. Select by Location Tool

5. Export each of the selected layers by right-clicking on the layer name, choosing Data, then
Export Data from the context menu. Save each as a feature class in the working
geodatabase with the respective names:

o MMC_DetailSheetExtents -> Detail_Sheets
o MMC_StandardSheetExtents -> Standard_Sheets
o Add the new Standard_Sheets layer to the map after exporting.

6. Remove the MMC_DetailSheetExtents and MMC_StandardSheetExtents national layers from
the map.
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7. Use the Select by Location tool located in the Selection menu to select features from the
COE_NID_DAMS layer that intersect the Standard_Sheets layer.

8. Use the Select by Attributes tool located in the Selection menu to select features from the
current selection in the COE_NID_DAMS layer that are USACE dams, or where the attribute
"COE_DAM" = "Yes'2

9. Export the selected features by right-clicking on the layer name, choosing Data, then Export
Data from the context menu. Save the layer to the working geodatabase as a feature class
named USACE_Dams.

10. Clear the selected features.

11. Use the Select by Location tool located in the Selection menu to select features from the
COE_NID_DAMS layer that are within a distance of one mile of the centerline.

12. Use the Select by Location tool located in the Selection menu to select features from the
current selection that intersect the InundationArea.

13. Use the Select by Attributes tool located in the Selection menu to select features from the
current selection in the COE_NID_DAMS layer that are Non-USACE dams, or where the
attribute "COE_DAM" = 'No'3

14. Export the selected features by right-clicking on the layer name, choosing Data, then Export
Data from the context menu. Save the layer to the working geodatabase as a feature class
named Non_USACE_Dams.

15. Remove the COE_NID_DAMS layer, as well as the newly created USACE_Dams and
Non_USACE_Dams layers, from the table of contents.

16. Use the Select by Location tool located in the Selection menu to select features from the
remaining layers that intersect the Standard_Sheets layer.

17. Export each of the selected layers by right-clicking on the layer name, choosing Data, then
Export Data from the context menu. Save each as a feature class in the working
geodatabase with the respective names:

dtl_cntry_In - Countries_Ln

dtl_cntry > Countries

dtl_cnty_In = Counties_Ln

dtl_cnty > Counties

dtl_st In > States_Ln

dtl_st > States

Railroad - Railroad

CityCivilDivisions - Cities
CityCivilDivisions_Ln - Cities_Ln
mgrs_region > USNG_Grid
MMC_Two_D_ Points > Two_D_Points
levee_centerline > Levee_Centerline
floodwall_line > Floodwall_Line
closure_structure_line > Closure_Structure_Line

O 0O 0O O0OO0OO0OO0OO0OO0OO0OO0oOO0oOOoOOo

If you are using the latest MMC National Mapping Data geodatabase, there is a field Called COE_Dam, which is set to “Yes” for
USACE Dams. Otherwise, the definition query WHERE “[FED_Own] LIKE ‘%CE%’” will capture the USACE dams from the
NID.

* Non-USACE dams will only appear in the maps where they are directly on or very near the centerline of the channel below the
study dam of an MMC project.
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18. The critical infrastructure points will be added to the Inundation geodatabase using the Copy
Critical Facilities to the Inundation Geodatabase tool on the MMC Toolbar

MMC Utilities Toolbar
150 v MMCToolsHelp= 8 @ RN &M E 3 o e & L Ha

Figure 3-3. Copy Critical Facilities to the Inundation Geodatabase

19. Source the MMC Geodatabase that contains the critical infrastructure points. All of the
feature classes in the Geodatabase that have “CIKR _” as the first 5 characters of the name

will be found.
20. Map to the Standard_Sheets layer and press Copy.
L
sl Copy Critical Facilities to the Inundation Geodatabase - - - T

I CIKR Geodatabase 22N MMC_2012_National_Mapping_Data_newdams* 10WMMC_Data_V2012 gdb E]

Critical Facility Layers it
CIKR_Aiparts
CIKR_Broadcast_Comm
CIKR_Chemical_Industries
CIKR_Colleges_Universities
CIKR_ComectionalFacilties
CIKR_Electric Substations
CIKR_EmengencyMedical
CIKR_Firestations_Fire
CIKR_Firestations_Fire_EMS
CIKR_FossilFusl_Power
CIKR_Heliports
CIKR_Hospitals b
CIKR_Hydro_Power

CIKR_Intermodal Shipping

CIKR_MaturalGas_Storage

CIKR_Muclear Power

CIKR_MuclearFuel_Manufacturing 57

m

Standard Sheets Layer  Standard_Sheets -

o

Figure 3-4. Copy Critical Facilities Tool
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3.6 MAP GRID SET UP

The Map Grid scale is designed to be uniform for all study areas. Some extreme cases will warrant a
different scale, but most of the study areas will use Standard Grids for use at a scale of 1:31,680 (1
inch="2 mile) and Detail Grids at a scale of 1:15,840 (1 inch="4 mile).

The Standard Grids in the data provided are for use at a scale of 1:31,680 and the provided Detail Grids
are for use at a scale of 1:15,840. Study areas that require a different scale will need to have new Grids
created. The process of Standard Sheet and Detail Sheet setup will be the same for all scales. A Map
Grid scale should be determined for each study area individually based on the number of sheets required
to complete mapping at a given scale.

The steps in this document will assume standard sheets for use at a scale 1:31,680 and detail sheets for
use at a scale of 1:15,840 are being used.

Determine if the predefined Standard Sheet Extents and Detailed Sheet Extents are appropriate for the
levee map. If the size and number of sheets is not appropriate, revise as needed to best fit the levee map
area. The following steps will refer to Standard and Detail sheets regardless if they are the predefined
data layers or custom sheets.

1. Add the Standard_Sheets, Detail_Sheets, Cities, InundationArea and USNG_ Grid feature
classes from the working geodatabase to a new ArcMap session. It may be helpful to also
add the World Street Map base map from ESRI image service as well.

2. Detail sheets should be used in areas where the inundation affects densely populated areas,
or areas where more detail is important. Use your judgment when selecting which detail
sheets should be active. The Cities feature class and the World Street Map base map can
be used for reference.

3. Two options exist for the selection of Detail _Sheets which will be included in the overall map
product.

o Use the select features tool to select all detail sheets that should be used and right
click on the layer name, choose data, then export to export the selected features to a
feature class in the working geodatabase with the name Detail_Sheets_Active.

4. Click the Calculate Page and Adjacent Page Numbers tool on the MMC Utilities Toolbar.

MMC Utilities Toolbar
1750 ~ MMCToolsHelp- 1B B R XIB B elne & L H

Figure 3-5. Calculate Page and Adjacent Page Numbers

5. Do not check box to change the Dam, Dam Owner and NIDID Name.
6. Fill out the rest of the form. Check on the box that says ‘Include “Active” Field in
Calculation.’Then Click “Calculate.”
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t® Calculate Page Numbers and Adjacent Sheets g

¥ Change Dam Mame, Dwner, and MIDID

Dam Mame IFaII Creek.

[ram Dwner Irm_l,.l Corps of Engineers, Portland District
NIDID |ORo0007

Select Map Sheet Layer IStandard_Sheets ;I

Select Detal Sheet Layer

Detal Sheets |

[ Include "Active” Figld in Calculation

MGRS Layer [USNG_Grid |

Cancel | Calculate |

Figure 3-6. Calculate Page Numbers Tool

The Calculate Page Numbers tool assumes that the page numbering scheme should start in the upper
left corner and progress right, then down as in Figure 19. This works well for some projects, but sheet
numbers should begin at the dam and progress downstream in an ordered fashion. In the case where the
standard numbering scheme does not work with the sheet layout, the sheets will need to be numbered
manually. This can be done completely manually, or the following steps can be followed:

¢ Run the Calculate Page Numbers Tool for the Standard and Detail sheet layers.
e Open a new Excel worksheet.
e Create two columns, “OldPage” and “NewPage” as shown in Figure 16.

& B
1 |OldPage InewPage

Mo doin Mo Jain

o= T N k2
L= I o R N s [ = TR =Y

11 9 9
Figure 3-7. Page Number Changes Table

e For each Standard Sheet, enter the original page number as calculated by the tool and the
new page number that should be used. Include “No Join"=“No Join” as well.

¢ Format the columns as Text, the default will be double. Make sure all formulas are converted
to values.

e Save the file to the GIS_Data folder in the Mapping directory as “NewSheetNbrs.xls”.

e Add the table to the ArcMap session.
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e If you have problems with the field types not translating between Excel and ArcGIS, export
the .xls table to the working geodatabase, add new text fields for the old and new page
numbers and use the field calculator to populate the text fields.

¢ Join the NewSheetNbrs table to the Standard_Sheets feature class using the PageNmbr field
and the OldPage field as shown in Figure 17.

Join Dakta ﬂ B

Join lets vou append additional data to this layer's atbribute table so you can,
for example, symbalize the layer's features using this data.

What do vwou want ko join ko this layver?

Join attributes from a kable j

1. Choose the Figld in this lawver that the join will be based on:

2. Choose the table ko join to this layer, or load the kable From disk:

I Mewsheethbrs j EI

[V Show the attribute tables of layers in this lisk

3. Choose the field in the table to base the join on:

IOIdPageTxt j

— Join Cptions
* Keep all records

&ll records in the karget table are shown in the resulting table.
Unmatched records will conkain null values For all Fields being
appended into the karget table From the join table.

" Keep only matching records

If a record in the target kable doesn't hawve a match in the join
table, that record is remowed From the resulting karget table,

About Joining Data | QK I Cancel |

Figure 3-8. Join New Sheet Numbers Table

¢ Right click on the Page_Nmbr column in the Standard_Sheets attribute table and choose the
field calculator. Calculate the Page_Nmbr field to equal the “NewPage” field from the joined
table.
Remove the join.
Repeat the two previous steps for each of the join fields; “North_Pg”, “South_Pg”, “West_Pg”
and “East_Pg".

e Remove the join.

e Join the Standard_Sheets attribute table to the Detail _Sheets attribute table using the
FID_USGS_S field.

e Use the following formula in the field calculator for the “Page_Nmbr” field in the Detail Sheets
feature class:

e [Standard_Sheets.Page Nmbr] & Right([Detail_Sheets_Active.Page_Nmbr],1)

e This will pull the new page number from the Standard_Sheets and append the detail sheet
letter to the end of it.

¢ Right click the field name for the North_Pg field and choose the field calculator. Check the
box next to “Show Codeblock” to open the pre-logic Pre-Logic Script Code editor. The code
below can be copied into the Pre-Logic Script Code window. The .cal file imbedded in the MS
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Word edition of this document can be saved to a local machine and used in lieu of copying or
re-typing the code below.

DetailloinPages.cal
Package 1. Cal File for Detail Sheet Join Pages (Code Below)
Dim Ltr
Dim Nbr
Dim NNbr
Dim SNbr
Dim WNbr
Dim ENbr
Dim N_Page
Dim S_Page
Dim W_Page
Dim E_Page
Dim NJoin
Dim SJoin
Dim EJoin
Dim WJoin
NJoin = [Detail_Sheets_Active.North_Pq]
SJoin = [Detail_Sheets Active.South_Pg]
EJoin = [Detail_Sheets_Active.East_Pg]
WJoin = [Detail_Sheets_Active.West_Pg]
Ltr = Right([Detail_Sheets_Active.Page_Nmbr],1)
Nbr = Left([Detail_Sheets_Active.Page_Nmbr],Len([Detail_Sheets_Active.Page_Nmbr])-1)
NNbr = [Standard_Sheets.North_Pq]
SNbr = [Standard_Sheets.South_Pg]
ENbr = [Standard_Sheets.East_Pq]
WNbr = [Standard_Sheets.West_Pq]

if Ltr = "a" then
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N_Page = NNbr & "c"
S Page = Nbr & "¢"
W_Page = WNbr & "b"
E_Page = Nbr & "b"
elseif Ltr = "b" then
N_Page = NNbr & "d"
S Page = Nbr & "d"
W_Page = Nbr & "a"
E_Page = ENbr & "a"
elseif Ltr = "c" then
N_Page = Nbr & "a"
S _Page = SNbr & "a"
W_Page = WNbr & "d"
E_Page = Nbr & "d"
elseif Ltr = "d" then
N_Page = Nbr & "b"
S_Page = SNbr & "b"
W_Page = Nbr & "c"
E_Page = ENbr & "¢"
End if
If NJoin = "No Join" Then N_Page = "No Join"
If SJoin = "No Join" Then S_Page = "No Join"
If WJoin = "No Join" Then W_Page = "No Join"

If EJoin = "No Join" Then E_Page = "No Join"

e The same code block can be used for the North_Pg, South_Pg, West_Pg, and East_Pg fields
to calculate the new join page numbers.

Use the variable N_Page when calculating the North_Pg field

Use the variable S_Page when calculating the South_Pg field

Use the variable W_Page when calculating the West_Pg field

Use the variable E_Page when calculating the East_Pg field

See Figure 14 for an example.
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Field Calculator EHE
Figlds: Tvpe! Functions:
Detail_Sheets_active, OBIECTID == £+ Number
Detail_Sheets_active FID_MMC_De

Detail_Sheets_active,¥_INDEY
Detail_Sheets_active.x_INDEY
Detail_Sheets_active,FID_MMC_Ma " Date
Detail_Sheets_active FID_LUSGS_S

Detail_Sheets_active.¥_INDEX_1

Detail_Sheets_active.x_INDEY_1

Detail_sheets_active,FID_nation

Detail_Sheets_active, STATE

Detail_Sheets_active LAT

Detal_shests_pckive LONG_ d

Pre-Logic VBA Scripk Code v advanced

Din Lty f’
Dimn Mbr

Dim MNMbr

Dim Shbr
Dimn Whibr

Dim EMbr =

4 | _’I_I
=
=

£~ String

Detail_Sheets_active Morth_Pg =
M_Page

I~ | Calculate selected records only
Data loaded.

Figure3-9. Field Calculator with Pre-Logic VBA

e Remove the Join.

e Check to make sure that all sheets are numbered according to plan.

e Print a PDF map of the new numbering convention and send it to the MMC Mapping
Technical Lead for District approval. Continue with the rest of the data processing steps.

7. Double check the sheet numbering and joining assignments. For Standard Sheet Grids, the
upper left corner will be assigned number 1 and the numbers will increase from left to right
by row so that the largest number will be the farthest right sheet of the last row.

8. For Detail Sheet Grids the upper left corner of the corresponding standard sheet will be
assigned the letter of “a” and the lettering will continue from left to right, by row. See Figure
19 for an example of the sheet numbering.
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Figure 3-10. Sheet Numbering Example

Table 3-1. Page Join Information

Field Name Populate with
North_Pg Sheet number North of the current sheet
South_Pg Sheet number South of the current sheet
East_Pg Sheet number East of the current sheet
West_Pg Sheet number West of the current sheet
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SECTION 4
Standard Sheet Development

The first step to creating any of the maps is to copy all of the template .mxd files from their location to the
ArcGISMaps folder in the Mapping folder for the working study area.

The Standard Sheets are created by opening 4.4.6 MMC_ StandardSheets.mxd and re-setting the data
sources for the various data layers. Once the .mxd for the Standard Sheets is set up the Map Book can
be generated, creating a map series for the study area.

41 SET DATA SOURCES

1. Open 4.4.6_ MMC_StandardSheets.mxd, the layers will have a red exclamation point next to
them; indicating the computer is not able to find a layer in the expected location.

2. Right click the layer name and choose Repair Data Source or go to the layer properties
dialog and under the Source tab, and set the data source. Point the layer source to the
correct feature class, either in the MMC National Mapping Data database or in the working
geodatabase created earlier.

Alternatively, you can click on the red exclamation point to set the data source for a single layer, and
ArcMap will automatically re-set the sources for all layers in the same workspace, given that the names of
the feature classes are the same. Make sure to check each layer and make sure that the correct feature
class was selected.

The layer order for the basemap layers is as follows:

4
e Anno

USACE_Dams_S_Anno
Non_USACE_Dams_S_Anno
St_S_Anno

Cnty_S_Anno

City_S_Anno

Grid_S_Anno

O O O 0O O O

e Base Map Elements
o CIKR Points

USACE Dams

Non-USACE Dams

Airports

Broadcast Communications
Chemical Industries

Colleges and Universities
State/Local Correctional Facilities
Electric Substations

Emergency Medical Services

You will remove existing annotation references in the .mxd, noting their order, and generate your own.
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Firestations — Fire Only

Firestations — Fire/EMS

Fossil Fuel Electric Power Generation and Other Power Generation
Heliports

Hospitals — General

Hydroelectric Power Generation
Intermodal Shipping Facilities

Law Enforcement

Natural Gas Storage

Nuclear Electric Power Generation
Nuclear Fuel Manufacturing

Petroleum Bulk Stations and Terminals
Potable Water Facilities

Schools

Wastewater Treatment Plants

o National Levee Database

e Closure Structure Lines
e Levee Centerlines
e Floodwall Lines

o Boundaries/Lines

USNG Grid
Standard Sheets
Lettered Points
Countries
o Countries (polygon) used for labeling
o Countries_Ln (line) used for symbology
e States
o States (polygon) used for labeling
o States_Ln (line) used for symbology
e Counties
o Counties (polygon) used for labeling
o Counties_Ln (line) used for symbology
o Cities
o Cities (polygon) used for labeling
o Cities (line) used for symbology
Railway Lines

o Inundation Elements
e Inundation Area

o World_Street Map
o Imagery Background

o Reference/World Transportation
¢ World Imagery




Map Production Guide for Levee Studies
FY2023 Standard Operating Procedure for Levees

4.2 SET DATA FRAME PROPERTIES

The Standard Sheet layer has a field that holds a rotation value for most of the UTM zones in the
continental U.S. This value will rotate the data frame so the sheet is oriented correctly on the page. Map
Book will apply this rotation to the main data frame when it is set up, however it is useful to set the
rotation on the data frames at this point when setting up the map. A representative rotation value can be
chosen from the attributes of the center-most Standard Sheet in the group to be mapped.

This rotation value should be used when setting up the index maps as well.

¢ Right click on the Layers and choose Properties. In the Coordinate System tab select the
coordinate system for the proper UTM Zone.

If the study area crosses UTM Zones, the process for creating Standard Sheets and Detail
Sheets will apply for all additional UTM Zones used. Each UTM Zone used will require a new
map book set up and pdf export.

Ensure that the horizontal units are set to meters.

4.3 MAP BOOK SET UP
For this section, when using ArcGIS v10, utilize the Data Driven Pages toolbar.

1. Right click on the Data Drive Pages set-up button on the left-side of the toolbar.

F B
Setup Data Driven Pages ' m
Definition | Extent

(_D What are data driven pages?

An index layer is used to produce multiple output pages using a single layout, Each page
shows the data at a different extent. The extents are defined by the features in the index
layer.

Enable Data Driven Pages

Index Layer Optional Fields
Data Frame: Rotation:
[Lavers - ] Rotlltmi4 -
Layer: Spatial Reference:
I‘@ Standard_Sheets ;I none - M
MName Field: Page Mumber:

Page_Nmbr - -

Sort Field: Skarting Page Mumber:

Page_Mmbr - 1

Sort Ascending

[ ok || cancel

Figure4-1. Setup Data Driven Pages

2. On the Definition Tab, check the box ‘Enable Data Driven Pages.’
a. Layer: Standard_Sheets
b. Name Field: Page_Nmbr
c. Sort Field: Page_Nmbr
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d. Rotation: Select the field for the correct UTM Zone
e. Page Number: Page_Nmbr
3. On the next page, under Extent, choose Center and Maintain Current Scale.
4. Click OK to create the map series.
5. Move between map atlas pages by typing the page number in the Data Driven Pages toolbar.

4.4 LINKED TEXT

ArcGIS 10.x uses Dynamic Text elements in the context of Data Driven Pages to get the same effect as
linked text in the older map book extension. There are a number of field-driven text elements that must be
set up.

Table 3 in the reference section lists the text elements that must be linked to the index attribute table, the
fields that they map to, and the rough location of the text element on the map panel.

1. Select the Text Element, as listed in Table 3 in the reference section.
2. Right-click on the Text Element to open the Properties Page. Use the following format for the
Tag:

o <dyn type = “page” property = “[index_layer_field_name]’/>

o For example, to make the Page Number text on the Map Book dynamic, the following
text would be typed in the Properties box, in the text box:

o <dyn type = “page” property = “Page_Nmbr"/>

3. Repeat for all the listed Text Elements in Table 3 in the reference section.

4. Make sure to change the NIDID, Dam Owner, Study Dam, and date (date when product is
ready for GIS Review) on the title block with the format described in the MMC Graphics
Specifications document.

4.5 ANNOTATION

Rather than using either the standard ESRI label engine or the Maplex labeling extension, the MMC maps
will use editable annotation feature classes to label features on the map. Annotation will be created per
study area

Table 4 in the reference section and Appendix 4.1.7, MMC Graphics Specifications, outline the layers that
need annotation built and the format to be used. Annotation should be built at a scale of 1:31,680 and
stored in the working geodatabase. The layers in the map template should have their label properties set
to the correct anno properties, but double check to make sure.

1. Turn the labels on one at a time for the appropriate features shown in Table 4 and the Map
Graphics Specifications.

2. Right click the current layer and select Convert Labels to Annotation making sure the correct
reference scale is set. Make sure that all other labels and annotation layers are turned off
prior to creating annotation. Turning off other layers will also speed performance.

3. Edit the annotation feature classes according to Table 4. For Counties, annotation should be
parallel to the county line if possible or leader to the county line and be in the correct county
where possible. County annotation should be placed at every instance of adjacent counties
per sheet. State Line annotation should also be parallel to the state line where possible.

4. Place annotation in an appropriate location without overlapping point features. Avoid placing

annotation in the inundation area if possible.

. If possible, place annotation so that it does not overlap ESRI generated labels in the
background. In some instances, annotation will have to overlap ESRI generated labels, this
is known and expected.

6. Itis recommended that mappers use the Annotation toolbar in ArcMap to edit the annotation

feature classes. It makes it easier and faster to display high quality annotation on the maps.

o
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7. If necessary, some annotation may have leader lines added. In order to set the annotation
leader line symbol properties, go to Editor on the Editor toolbar and click Options.
8. On the Annotation tab, click the Leader button

Set the leader line symbology to the symbology found in the Graphics Specification document
4.6 EXPORT TO PDF

Once the map series is properly set up, export the map series to the AtlasPages folder under the
FullResolution folder in the PDF Maps directory. Turn off or remove from the table of contents the base
data feed that you are not including in the maps (World_Street Map, or World_Imagery) prior to
exporting.

Make sure all guides are turned off, labels are turned off, and selected features have been cleared before
exporting to pdf.

9. Go to File > Export Map

2. Under the General tab, Use the default settings of 300 dpi, Normal resample ratio (1:3).

3. Under the Format tab, check ‘Compress Vector Graphics’ and ‘Embed All Document Fonts’
boxes. Set the Image Compression to ‘None.’

General Fommat | Pages | Advanced

Destination Colorspace:  RGE -

Compress Vector Graphics

Image Compression: Mone -

Cluality: Low - ' LES
Picture Symbal: Hasterize layers with bitmap marersfills -

7] Convert Marker Symbols to Polygons
Embed Al Document Fonts

[] Clip Output to Graphics Exdent
Figure 4-2. PDF Export Settings

4. Under the Pages tab, check the ‘All’ box and change the ‘Export Pages As’ option to ‘Multiple
PDF Files (page names).’

5. Click Save to export the street series to the appropriate location as .pdf files and name
accordingly. There is no need to add the Page Number onto the Standard Sheet export
names, as the Page Number will automatically append to the end of the PDF name. Once
the street series has passed the Mapping Review, and all edits have been made, the aerial
series should also be exported.

LFIM_[Fiscal Year]_[Levee Name]_[Scenario]_S_[Page Number].pdf (street view)

LFIM_[Fiscal Year]_[Levee Name]_[Scenario]_A_[Page Number].pdf (aerial view)
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SECTION 5
Detail Sheet Development

The Detail Sheets are created by opening 4.4.7_MMC_DetailSheets.mxd and setting the data sources for
the various data layers. Once the individual Detail Sheets are set up the Map Book can be set-up,
creating a Sheet for each panel in the series.

5.1 SET DATA SOURCES

1. Open 4.4.7_MMC_DetailSheets.mxd, the layers will have a red exclamation point next to
them; indicating the computer is not able to find a layer in the expected location.

2. Right click the layer name and choose Repair Data Source or go to the layer properties
dialog and under the Source tab, and set the data source. Point the layer source to the
correct feature class, either in the MMC National Mapping Data database or in the working
geodatabase created earlier (feature class sources are listed in Appendix 4.1.6, MMC Data
Specifications). Alternatively, you can click on the red exclamation point to set the data
source for a single layer, and ArcMap will automatically re-set the sources for all layers in
the same workspace, given that the names of the feature classes are the same.

3. The layer order for the basemap layers is as follows:

5
e Anno

USACE_Dams_D_Anno
Non_USACE_Dams_D_Anno
St D_Anno

Cnty_D_Anno

City_D_Anno

Grid_D_Anno

O O O O O O

o Base Map Elements
o CIKR Points

USACE Dams

Non-USACE Dams

Airports

Broadcast Communications
Chemical Industries

Colleges and Universities
State/Local Correctional Facilities
Electric Substations

Emergency Medical Services
Firestations — Fire Only
Firestations — Fire/EMS

Fossil Fuel Electric Power Generation and Other Power Generation
Heliports

Hospitals — General

You will remove existing annotation references in the .mxd, noting their order and generate your own.
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Hydroelectric Power Generation
Intermodal Shipping Facilities

Law Enforcement

Natural Gas Storage

Nuclear Electric Power Generation
Nuclear Fuel Manufacturing

Petroleum Bulk Stations and Terminals
Potable Water Facilities

Schools

Wastewater Treatment Plants

o National Levee Database

Closure Structure Lines
Levee Centerlines
Floodwall Lines

o Boundaries/Lines

USNG Grid
Standard Sheets
Countries

= Countries (polygon) used for labeling
=  Countries_Ln (line) used for symbology

States

= States (polygon) used for labeling
= States_Ln (line) used for symbology

Counties

= Counties (polygon) used for labeling
= Counties_Ln (line) used for symbology

Cities

= Cities (polygon) used for labeling
= Cities (line) used for symbology

Railway Lines

o Inundation Elements

Inundation Area

o World_Street Map
o Imagery Background

Reference/World Transportation
World Imagery
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5.2 SET DATA FRAME PROPERTIES

The Detail Sheet layer has a field that holds a rotation value for most of the UTM zones in the continental
US. This value will rotate the data frame so the sheet is oriented correctly on the page. Map Book will
apply this rotation to the main data frame when it is set up, however it is useful to set the rotation on the
data frames at this point when setting up the map. A representative rotation value can be chosen from the
attributes of the center-most Detail Sheet in the group to be mapped.

1. Right click on the Layers and choose Properties. In the Coordinate System tab select the
coordinate system for the proper UTM Zone. If the study area crosses UTM Zones, the
process for creating Standard Sheets and Detail Sheets will apply for all additional UTM

Zones used.
2. Each UTM Zone used will require a new map book set up and pdf export. Ensure that the

horizontal units are set to meters.
3. Inthe General Tab, set the rotation value to the rotation value from the Detail Sheet attribute

table for the current UTM zone.

5.3 MAP BOOK SET UP

The Detail Sheet layer has a field that holds a rotation value for most of the UTM zones in the continental
US. This value will rotate the data frame so the sheet is oriented correctly on the page. Map Book will
apply this rotation to the main data frame when it is set up, however it is useful to set the rotation on the
data frames at this point when setting up the map. A representative rotation value can be chosen from the
attributes of the center-most Detail Sheet in the group to be mapped.

1. Right click on the Layers and choose Properties. In the Coordinate System tab select the
coordinate system for the proper UTM Zone. If the study area crosses UTM Zones, the
process for creating Standard Sheets and Detail Sheets will apply for all additional UTM

Zones used.
2. Each UTM Zone used will require a new map book set up and pdf export. Ensure that the

horizontal units are set to meters.
3. Inthe General Tab, set the rotation value to the rotation value from the Detail Sheet attribute

table for the current UTM zone.
54 MAP BOOK SET UP

For this section, when using ArcGIS v10, utilize the Data Driven Pages toolbar.

1. Right click on the Data Drive Pages set-up button on the left-side of the toolbar.
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F ™
Setup Data Driven Pages - @g
Definttion | Extert

@ What are data driven pages?

An index layer is used to produce multiple output pages using a single layout. Each page
shows the data at a different extent. The extents are defined by the features in the index
layer.

Enable Data Driven Pages

Index Layer Optional Fields
Data Frame: Rotation:
[Lavers b ] RotUtmi4 -
Layer: Spatial Reference:
I'é’ Standard_Sheets ;I none - M
MName Field: Page Mumber;

Page_Nmbr M -
Sort Field: Skarting Page Mumber:

Page_Nmbr - 1

Sort Ascending

[ ok || Ccancel

Figure 5-1. Setup Data Driven Pages

2. On the Definition Tab, check the box ‘Enable Data Driven Pages.’

Layer: Detail_Sheets_Active

Name Field: Page_Nmbr

Sort Field: Page_Nmbr

Rotation: Select the field for the correct UTM Zone
Page Number: Page_Nmbr

O O O O O

3. On the next page, under Extent, choose Center and Maintain Current Scale.
4. Click OK to create the map series.
5. Move between map atlas pages by typing the page number in the Data Driven Pages toolbar.

5.5 LINKED TEXT

ArcGIS 10.x uses Dynamic Text elements in the context of Data Driven Pages to get the same effect as
linked text in the older map book extension. There are a number of field-driven text elements that must be
set up.

Table 3 in the reference section, lists the text elements that must be linked to the index attribute table, the
fields that they map to, and the rough location of the text element on the map panel.

6. Select the Text Element, as listed in Table 3 in the reference section.
7. Right-click on the Text Element to open the Properties Page. Use the following format for the
Tag:

8. <dyn type = “page” property = “[index_layer_field_name]’/>
9. For example, to make the Page Number text on the Map Book dynamic, the following text
would be typed in the Properties box, in the text box:
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a. <dyn type = “page” property = “Page_Nmbr"/>

10. Repeat for all the listed Text Elements in Table 3 in the reference section.

11. Make sure to change the NIDID, Dam Owner, Study Dam, and date (date when product is
ready for GIS Review) on the title block with the format described in the MMC Graphics
Specifications document.

5.6 ANNOTATION

Rather than using either the standard ESRI label engine or the Maplex labeling extension, the MMC maps
will use editable annotation feature classes to label features on the map.

Annotation will be created per study area, Table 4 in the reference section and Appendix 4.1.7, MMC
Graphics Specifications, outlines the layers that need annotation built and the format to be used.
Annotation should be built at a scale of 1:31,680 and stored in the working geodatabase. The layers in
the map template should have their label properties set to the anno properties, but double check to make
sure.

12. Label the appropriate features shown in Table 4 and the Map Graphics Specifications.

2. Right click the current layer and select Convert Labels to Annotation making sure the correct
reference scale is set.

3. Edit the annotation feature classes according to Table 4. For Counties, annotation should be
parallel to the county line if possible or leader to the county line and be in the correct county
where possible. County annotation should be placed at every instance of adjacent counties
per sheet. State Line annotation should also be parallel to the state line where possible.

4. Place annotation in an appropriate location without overlapping point features. Avoid placing
annotation in the inundation area if possible.

5. If possible, place annotation so that it does not overlap ESRI generated labels in the
background. In some instances, annotation will have to overlap ESRI generated labels, this
is known and expected.

6. It is recommended that mappers use the Annotation toolbar in ArcMap to edit the annotation
feature classes. It makes it easier and faster to display high quality annotation on the maps.

7. If necessary, some annotation may have leader lines added. In order to set the annotation
leader line symbol properties, go to Editor on the Editor toolbar and click Options.

8. On the Annotation tab, click the Leader button

Set the leader line symbology to the symbology found in the Graphics Specification document
5.7 EXPORT TO PDF

Once the map series is properly set up, export the map series to the AtlasPages folder under the
FullResolution folder in the PDF Maps directory. Turn off or remove from the table of contents the base
data feed that you are not including in the maps (World_Street Map, or World_Imagery) prior to
exporting.

Make sure all guides are turned off, labels are turned off, and selected features have been cleared before
exporting to pdf.

9. Go to File > Export Map

2. Under the General tab, Use the default settings of 300 dpi, Normal resample ratio (1:3).

3. Under the Format tab, check ‘Compress Vector Graphics’ and ‘Embed All Document Fonts’
boxes. Set the Image Compression to ‘None.’
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General Format | Pages I Advanced

Destination Colorspace:  RGE -

Compress Vector Graphics

Image Compression: Mone -

Cluality: Low - i bl &
Ficture Symbal: Rasterize layers with bitmap markersfills

[] Convert Marker Symbols to Palygons
Embed Al Document Fonts

[] Clip Output to Graphics Edent

Figure 5-2. PDF Export Settings

4. Under the Pages tab, check the ‘All' box and change the ‘Export Pages As’ option to ‘Multiple
PDF Files (page names).’

5. Click Save to export the street series to the appropriate location as .pdf files and name
accordingly. There is no need to add the Page Number onto the Standard Sheet export
names, as the Page Number will automatically append to the end of the PDF name. Once
the street series has passed the Mapping Review, and all edits have been made, the aerial
series should also be exported.

LFIM_[Fiscal Year]_[Levee Name]_[Scenario]_S_[Page Number].pdf (street view)

LFIM_[Fiscal Year]_[Levee Name]_[Scenario] A _[Page Number].pdf (aerial view)
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SECTION 6
Sheet Index Map Creation

The Sheet Index Map is a full-sized index for the entire study area. It consists of a main map data frame
that shows the full extent of the study area and a locator map showing an even larger area. The map
uses the same data sources as the Standard Sheets but is displayed at a different scale. The Sheet Index
Map template file is included as 4.4.5 MMC_Sheet_Index.mxd.

6.1 SET DATA SOURCES

1. Open 4.4.5_MMC_Sheet_Index.mxd. The layers will have a red check mark next to them;
indicating the computer is not able to find a layer in the expected location.

2. Reference each layer by either right clicking the layer name and choosing Repair Data
Source or going to the layer properties dialog and under the Source tab, setting the data
source.

3. Point the layer source to the correct feature class, either in a Corps-Map database or in the
working geodatabase created earlier. The state and county lines should be used from the
national data geodatabase to show data outside of the mapped extents.

6.2 SET DATA FRAME EXTENTS
Each of the data frames on the map need the extents set.

1. Right click on the Standard_Sheets layer and select Zoom to Layer, to zoom the data frame
to the study extents.

2. Set a reference scale that displays all of the Standard_Sheets and some area outside of the
Standard Sheets Grid. Each study dam will have a different reference scale depending on
the number of sheets and size of study area.

3. Open the Data Frame Properties dialog box and under the “General” tab, paste the rotation
value from the Standard_Sheets into the text box for rotation and change the coordinate
system to the appropriate UTM for the study area.

4. For the locator map data frame, add an extent rectangle and zoom to the appropriate location
of the study dam. Use the same coordinate system and rotation value as in the main data
frame.

5. Set the reference scale so that the extent rectangle is in the center of the data frame. The
“Index Extents” text should be pointing at the extent rectangle

6. In the locator map data frame, create annotation for State Line. Format for text is: Arial
Narrow, size 14, black, bold, white halo 1 point.

6.3 SHEET INDEX MAP ANNOTATION

The required annotation for the Index Sheet Map can be found in Table 4 and more detail can be found in
the MMC Graphics Specification Document. Annotation should be built at Sheet Index Map scale and
stored in the working geodatabase.

1. Label the appropriate features in the index, following the description in Table 4 in the
reference section and the Graphics Specifications.

2. Right click the current layer and select Convert Labels to Annotation making sure the
correct reference scale is set for the index.
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Annotation should be placed in an appropriate location without overlapping other important features. If
possible, place annotation so that it does not overlap ESRI generated labels. In some instances,
annotation will have to overlap ESRI generated labels, this is known and expected.

6.4 EXPORT TO PDF
Once the map is set up properly, export the map to the AtlasPages folder under the FullResolution folder.
Make sure all guides are turned off and selected features have been cleared before exporting to pdf.

1. Go to File > Export Map

2. Under the General tab, Use the default settings of 300 dpi, Normal resample ratio (1:3).

3. Under the Format tab, check ‘Compress Vector Graphics’ and ‘Embed All Document Fonts’
boxes. Set the Image Compression to ‘None.’

Genersl Fomat | Pages | Advanced

Destination Colorspace:  RGE -

Compress Vector Graphics

Image Compression: Mone -

Cluality: Low ' bl
Ficture Symbal: Rasterize layers with bitmap markersfills -

[] Convert Marker Symbols to Palygons
Embed Al Document Fonts

[ Clip Qutput to Graphics Exent

Figure 6-1. PDF Export Settings

Name the .pdf file:

LFIM_[Fiscal Year]_[Levee Name]_[Scenario Sheet] Index.pdf
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SECTION 7
Cover Page Set Up

The cover page will be standard for all study areas, with the information on the title block changing for
each study area. The cover page will be provided to you and named
4.41_MMC_Cover_Page_Levee.pptx.

Appendix 4.1.7, MMC Map Graphics Specifications, shows an example of the cover page and title block.
Follow the layout and format as described in the MMC Map Graphics Spec document.

1. Open the cover page template in MS PowerPoint, update the title block with the following
information:

Levee Name

Map Series (Street or Aerial)

Scenario Name

Production Date (Month and Year when map product is ready for 50 percent internal
review)

Levee ID

Levee Owner name, two lines

U.S. Army Corps of Engineers

Kansas City District

O O O O

o O

2. After the title block information has been edited, print the cover page to a pdf file.
Name the .pdf file:
LFIM_[Fiscal Year]_[Levee Name]_[Scenario]_Cover_Page_Street.pdf

or

LFIM_[Fiscal Year]_[Levee Name]_[Scenario]_Cover_Page_Aerial.pdf
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SECTION 8
Map Notes Pages

The Map Notes Pages are standard for all study areas and will be provided to you as
4.4.2 MMC_MapNotesl Levee.mxd and 4.4.3 MMC_MapNotesll_Levee.mxd.

Map Notes I:

1.
2.
3.

4.

Modify the arrival time and depth legend as needed for your study.

Save the .mxd file for the specific study area.

Export the Notes Pages to a .pdf file. Make sure all guides are turned off and selected
features have been cleared before exporting to pdf.

Name the pdf file: LFIM_[Fiscal Year]_[ Levee Name]_[Scenario]_MapNotes|.pdf

Map Notes Il

1.

Nookw

®

Use the .mxd template and the 4.4.7_MapNotes2_Tables_Study_Levce.xIsx to create the
map notes Il page. Information can be found in the modeling report.

The tables will need to be filled out using the Excel template and then copied and pasted into

the Map Notes Il page template as a picture.

Typically, only the scenarios being mapped will need to be displayed in the chart.

Add screen shots or other illustrations can be added to the page as needed:

Insert any notes that are specific to the study area being mapped.

Delete any of the template text if you do not use the text elements for your notes.

Insert any supporting graphics needed for the notes.

Save the .mxd file for the specific study area.

From the File menu, select print and choose the printer named Adobe PDF.

Click on the Properties button. In the Layout tab, set the layout to Landscape.

Set the output page size to Tabloid (11 by 17 inch). Save the pdf in the AtlasPages folder
under the FullResolution folder.

Name the pdf file: LFIM_[Fiscal Year]_[ Levee Name]_[Scenario] MapNotesll.pdf
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SECTION 9
PDF Inundation Atlas Creation

9.1 BUILDING INUNDATION ATLASES
1. Consolidate the exported PDF maps to include:

Cover Page

Notes |

Notes Il

Sheet Index

All study scenario maps for a breach location

O O O O O

2. Save the Inundation Atlases with names similar to the format of:
LFIM_[Fiscal Year]_[ Levee Name]_[Breach Location] A DIGITAL_Atlas.pdf
A digital hard copy of the aerial inundation atlas
LFIM_[Fiscal Year]_[ Levee Name]_[Breach Location]_S_DIGITAL_Atlas.pdf
A digital hard copy of the street inundation atlas

9.2 OPTIMIZING PDF FILES

1. Use Adobe Acrobat Pro to create reduced sized PDFs. Save the optimized PDFs with the
same names in a new folder.
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Edit View Window Help

E Qpen... Ctrl+0

E.a Reopen PDFs from last session

f‘b Create U
Save as Other 5 Reduced Size PDF... I
Export To ' Certified PDF...

=}
|
T

1 ZNALFIM_2017_Clinton_DSL_Aerial.pdf

2 N:..A\[Non-DoD Source] ...tion #86686625.pdf
3 C\AGB9125 - ICW - 237 (7-23-19).pdf

4 C\.N\469123 - OMRI DAMS (7-23-19).pdf

5 CAANWS_FY20_PendOreilleFIM_combined.pdf

View All Recent Files...

Exit Ctrl+Q

Figure 9-1. Optimization

2. Verify that files have been optimized by comparing the file sizes of the original pdfs to the
newly created pdfs. The original file sizes will be approximately 25,000-30,000 KB while the
new file sizes should be approximately 500-1,500 KB.
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SECTION 10
Mapping Reviews

The mapping products produced for the MMC are reviewed at two levels within the MMC program and
optionally outside the program. The Initial review is an internal GIS/Mapping team review. An assigned
member of the GIS/Mapping team will review all products at this point. The Modeler review is an H&H
review by a member of the MMC H&H team as assigned. Refer to Appendix 4.3.7, MMC Mapping Review
Guide, for details on the review process. Below are the descriptions of the mapping products at the
review milestones.

10.1 INTERNAL MAP REVIEW

Each mapping team should conduct an internal review by another MMC mapper in the district before
maps are sent for the further review.

Map Review 1:

Optimized digital street view atlas should be uploaded to the “MMC Maps for Review” section of
the SharePoint site.

A review will be conducted and the reviewed pdf file and review checklist will be returned to the
mapping team through the SharePoint site.

The GIS/Mapping team member will address all comments.

Map Review 2:

Updated optimized digital street view atlas should be uploaded to the “MMC Maps for Review”
section of the SharePoint site.

A review will be conducted to verify all edits were completed from the first map review and no
new edits are required. The completed review checklist will be returned to the mapping team
by e-mail with the request for the shipment of all mapping data.

The completed review checklist should be saved in the Mapping subfolder under the Review
folder.

Final data should be shipped on an external hard drive to the Kansas City District for storage.

MMC Review:

An optional review may be completed by any member of the MMC production center, MMC customer, or
member of the MMC Steering Committee. This review will be on an as-requested basis, not initiated by
the GIS/Mapping team. The GIS/Mapping team lead will deliver the entire study area file structure to the
reviewer and any comments received in return will be addressed by an assigned member of the
GIS/Mapping team.
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SECTION 11
Printing Requirements

11.1 PRINTING

When printed and assembled the Inundation Atlas will have a final size of 11 by 17 inches. Most pages in
the Inundation Atlas will be printed on 11 by 17-inch paper, but some pages will be printed on larger
paper and folded to fit the 11 by 17-inch book.

The final MMC Map Product will be assembled with the following format:

e Map Cover Page
e Map Notes Page
e Sheet Index Map
e Standard Sheets and Detail Sheets as per study area

11.2 GENERAL PRINTING REQUIREMENTS

Most pages will be printed on 11 by 17-inch paper, using double sided printing.

From the combined Inundation Atlas .pdf file you created, print the .pdf file using double sided printing.
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SECTION 12

Inundation Atlas Hard Copy Map
Product Assembly

The Inundation Atlas is an 11 by 17-inch bound book. The printed pages will be assembled in the
following order:

e Map Cover Page

e 2 Map Notes Pages

e Sheet Index Map

e Standard Sheets and Detail Sheets as per study area

A clear overlay will be on top of the Map Cover Page and a black cardstock backing will be added in the
binding process.

Please see the provided hard copy sample for better understanding of the layout of the map product.
More information on the binding process will be provided at a later date.




Map Production Guide for Levee Studies
FY2023 Standard Operating Procedure for Levees

SECTION 13
Reference

Table 13-1. Linked Text

Sheet No. Page_Nmbr Title Block

Left Joins Tab West_Pg Sheet

Top Joins Tab North_Pg Sheet

Bottom Joins Tab South_Pg Sheet

Right Joins Tab East_Pg Sheet

USNG Grid Zone USNG_GZzZD Above Scale Bar
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White Halo 1 pt

Leader Line Parallel to county line
Standard Arial Width: 1.0 Pt *If table provides name
Counties Cnty_S_Anno Sheet Narrow 14 Black Bold Color: RO, GO, BO only add “County” to text
Standard
Countries Cntr_S_Anno Sheet Arial Black | 14 Black Normal White Halo 2 pt Parallel to line
White Halo 1 pt
Leader Line
Standard Avrial Width: 1.0 Pt Parallel to state line
States St S _Anno Sheet Narrow 14 Black Bold Color: RO, GO, BO All Caps
Standard Mars
USACE Dams NID_S Anno Sheet Arial 11 Red Italics White Halo 1 pt All Caps
Cherryw
Standard ood
Non USACE Dams NID_S_Anno Sheet Arial 11 Brown Italics White Halo 1 pt All Caps
White Halo 1 pt
Leader Line
Municipalities\Cities City_S_Anno Sheet Arial Black | 12 Black Italics Color: RO, GO, BO
White Halo 1 pt
Leader Line Parallel to county line
Detail Avrial Width: 1.0 Pt *If table provides name
Counties Cnty_D_Anno Sheet Narrow 14 Black Bold Color: RO, GO, BO only add “County” to text
Detail
Countries Cntr_D_Anno Sheet Arial Black | 14 Black Normal White Halo 2 pt Parallel to line
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White Halo 1 pt
Leader Line
Detail Arial Width: 1.0 Pt Parallel to state line
States St D_Anno Sheet Narrow 14 Black Bold Color: RO, GO, BO All Caps
Detail Mars
USACE Dams NID_D_Anno Sheet Arial 11 Red Italics White Halo 1 pt All Caps
Cherryw
NID_Dams_D_An | Detall ood
Non USACE Dams no Sheet Arial 11 Brown Italics White Halo 1 pt All Caps
White Halo 1 pt
Leader Line
Detail Width: 1.0 Pt
Municipalities\Cities City_D_Anno Sheet Arial Black | 12 Black Italics Color: RO, GO, BO
White Halo 1 pt
Leader Line
Avrial Width: 1.0 Pt
Counties Cnty_I_Anno Index Narrow 12 Black Bold Color: RO, GO0, BO Level
Countries Cntr_|_Anno Index Arial Black | 12 Black Normal White Halo 2 pt Parallel to line
USACE_Dams | Mars
USACE Dams Anno Index Arial 12 Red Italics White Halo 1 pt All Caps
Cherryw
Non_USACE_Da ood
Non USACE Dams ms_|_Anno Index Arial 12 Brown Italics White Halo 1 pt All Caps
White Halo 1 pt
Leader Line
Arial Width: 1.0 Pt Parallel to state line
States St | Anno Index Narrow 12 Black Bold Color: RO, GO0, BO All Caps
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RO, G92,
Detail Sheet Number Detail_I_Anno Index Arial 12 B230 Bold White halo 1 pt Black Outline 0.4 pt
Standard Sheet R255, G
Number Stand_|_Anno Index Arial 12 0, B0 Bold White halo 1 pt Black Outline 0.5 pt
White Halo 1 pt
Leader Line
States St L_Anno Locator Narrow 10 Black Bold Color: RO, GO, BO Horizontal
Index White Halo 1 pt
Countries Cntry_L_Anno Locator Arial Black | 10 Black Bold No leader Parallel to Line
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